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Sobre Este Documento

Os produtos IBM® WebSphere™ Business Integration Server Express e IBM®
WebSphere® Business Integration Server Express Plus sao constituidos pelos
seguintes componentes: InterChange Server Express, o Toolset Express associado,
CollaborationFoundation, e um conjunto de adaptadores de integracdo de software.
As ferramentas no Toolset Express o ajudam a criar, modificar e gerenciar
processos de negécios. Vocé pode escolher entre os adaptadores pré-empacotados
para seus processos de negdcios que abrangem os aplicativos. O gabarito de
processos padrdo, CollaborationFoundation, permite que vocé crie processos
personalizados rapidamente.

Exceto quando indicado, todas as informagdes neste guia aplicam-se ao IBM
WebSphere Business Integration Server Express e ao IBM WebSphere Business
Integration Server Express Plus. O termo “WebSphere Business Integration Server
Express” e suas variagdes se referem a ambos os produtos.

As amostras SystemTest sao fornecidas como uma forma de validagdo dos sistemas
IBM WebSphere Business Integration Server Express V4.3.1 e IBM WebSphere

Business Integration Server Express Plus V4.3.1 apds a instalagéo.

Este documento descreve como utilizar essas amostras para validar seus sistema.

Publico-alvo

Este documento é destinado a consultores e administradores de sistema que
instalam, implementam e administram o IBM WebSphere Business Integration
Express.

Documentos Relacionados

O conjunto completo da documentagdo disponivel com este produto descreve os
recursos e componentes comuns a todas as instalagdes do IBM WebSphere Business
Integration Server Express, e inclui material de referéncia para componentes
especificos.

Vocé pode fazer download, instalar e visualizar a documentac¢do no seguinte site:
http:/ /www.ibm.com /software/integration / wbiserverexpress /library /infocenter]

Apbs completar as instrugdes fornecidas neste documento para validagdo da
instalagdo de seu produto, consulte os documentos listados abaixo para obter mais
informagdes sobre essas tarefas especificas.

* Para obter informacdes sobre os produtos IBM WebSphere Business Integration
Server Express e Express Plus e as etapas necessdrias para implementar uma
solucdo, consulte a publicagdo System Implementation Guide.

* DPara obter informacdes sobre a instalagdo do Adaptador opcional ou dos Pacotes
de Capacidade de Colaboracao, disponiveis somente com o produto WebSphere
Business Integration Server Express Plus, consulte a publicacdo WebSphere
Business Integration Server Express Installation Guide for Windows, WebSphere
Business Integration Server Express Installation Guide for OS/400 ou a publicagdo
WebSphere Business Integration Server Express Installation Guide for Linux.
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* Para obter informacdes sobre a realizagdo das tarefas de configuracdo final para
sua implementacdo, incluindo a configuracdo dos adaptadores instalados com o
WebSphere Business Integration Server Express e o Express Plus, além do Pacote
de Capacidade do Adaptador opcional, consulte a publicagdo System
Implementation Guide.

Notas:

1. Nas amostras SystemTest, os adaptadores foram configurados para utilizar o
IDL como o mecanismo de transporte. Essas amostras ndo testam uma
implementagédo utilizando o J]MS como o mecanismo de transporte. Para obter
informagdes sobre como configurar adaptadores para utilizar o J]MS como o
mecanismo de transporte, consulte a publicacdo System Implementation Guide.

2. Informagdes importantes sobre este produto podem estar disponiveis nos
Technotes e Flashes de Suporte Técnico emitidos depois da publicagdo deste
documento. Eles podem ser localizados no Web site do WebSphere Business
Integration Support,

[http: / /www.ibm.com /software/integration /websphere /support/} Selecione a
area de componentes de interesse e procure as se¢des Technotes e Flashes.

Convencoes Utilizadas neste Guia

vi

Este documento utiliza as seguintes abrevia¢des e convengoes de estilo:

* Sdo utilizadas abreviagdes para algumas palavras e algumas varidveis em
instrugdes de sintaxe. As seguintes abrevia¢des sao utilizadas:

BO = objeto de negdcios (prefixo de um ip_address = nome varidvel de um endereco
arquivo de BO) P

collaboration_name = nome variavel para uma ObjectName = nome variavel de um objeto de
colaboracao negocios

connector_name = nome varidvel de um 0s400Name = variavel para o nome do
conector sistema OS/400 ou seu endereco IP

ICS = InterChange Server Express

BO é o prefixo do arquivo BO; o termo BO geralmente se refere a arquivos de texto
de defini¢do de objeto de negdcios. ObjectName se refere as varidveis utilizadas
para representar objetos de negdcios.

¢ O termo “camelcase,” utilizado neste documento, refere-se a um estilo de uso de
letras maitisculas no qual os espacos entre as palavras sdo eliminados e a
primeira letra de cada palavra (ou mais de uma letra, caso seja um acrénimo) é
escrita com letras maitisculas. Por exemplo, o termo SystemTest estd em
camelcase.

Além disso, este documento utiliza algumas ou todas as convengdes tipogréficas a

seguir:

Negrito Indica um valor literal, tal como um nome de comando,
nome de arquivo, informagdes que vocé digita ou
informacdes que o sistema imprime na tela.

itdlico Indica um nome de varidvel, uma referéncia cruzada ou um
novo termo que estd aparecendo pela primeira vez.

contorno azul O texto azul, que fica visivel apenas quando vocé visualiza o

manual on-line, indica um hyperlink de referéncia cruzada.
Clique dentro do contorno para ir para o objeto da
referéncia.
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{} Em uma linha de sintaxe, as chaves circundam um conjunto
de opgdes a partir das quais vocé deve escolher uma e
apenas uma.

[1 Em uma linha de sintaxe, os colchetes circundam um
parametro opcional.

Em uma linha de sintaxe, as reticéncias indicam uma
repeticdo do parametro anterior. Por exemplo, opgaol,...]
significa que vocé pode digitar varias opgdes separadas por
virgula.

<> Em uma convengdo de nomenclatura, sinais de menor e
maior envolvem elementos de um nome para distingui-los
uns dos outros, como em
<nome_do_servidor><nome_do_conector>tmp.log.

/. \ Neste documento, barras (/, \) sdo utilizadas como
convengdo para os caminhos de diretério. Todos os nomes
de caminho de produtos do sistema IBM WebSphere
Business Integration Server Express sdo relativos aos
diretérios onde o produto é instalado em seu sistema.

%text% e $text Texto entre sinais de porcentagem (%) indicam o valor da
varidvel de sistema de texto ou variavel de usuério.
ProductDir Representa o diretério no qual o produto esta instalado.

Novidades no Release 4.3.1

Este release inclui suporte para o InterChange Server Express nos seguintes
sistemas operacionais:

+ IBM OS/400 V5R2, V5R3

* Red Hat Enterprise AS Linux 3.0, Atualizagdo 1
* SuSE Linux Enterprise Server 8.1 com SP3

* Microsoft Windows 2003

Novidades no Release 4.3

Este é o primeiro release deste guia.

Sobre Este Documento Vil
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Capitulo 1. Visao Geral do Guia de Inicializacao Rapida

Este documento descreve como utilizar as amostras SystemTest para validar o
sistema apds instalar as edi¢gdes para Windows, OS/400 ou Linux dos produtos
IBM® WebSphere™ Business Integration Server Express V4.3.1 ou IBM®
WebSphere™ Business Integration Server Express Plus V4.3.1.

Exceto quando indicado, todas as informagoes neste guia aplicam-se ao IBM
WebSphere Business Integration Server Express e ao IBM WebSphere Business
Integration Server Express Plus. O termo WebSphere Business Integration Server
Express e suas variagdes se referem a ambos os produtos.

Os capitulos “Validando Sua Instalacdo do Windows,” “Validando sua instalagdo
do OS/400” e “Validando Sua Instalagdo do Linux” terminam com uma seciao
chamada "Préxima Etapa a Ser Executada”. Essas se¢bes resumem o que vocé
executou até aqui e o instruem a prosseguir para o capitulo “Limpando os Objetos
de Negocios” para importar o arquivo de pacote BIA_BO_BaseCollabBOs.jar na
biblioteca de componentes de integracao de WBIExpressLibrary e, em seguida,
implementar os objetos de negdcios Customer e Employee no servidor antes de
utilizar seu produto IBM WebSphere Business Integration Server Express. A segdo
“Préximas Etapas a Serem Executadas” no final do capitulo “Limpando o Objeto
de Negocios” fornece sugestdes a respeito do que deve ser feito apds concluir as
instrucdes neste documento.

Entrando em Contato com o Suporte do Produto

Para problemas de suporte relacionados a produtos IBM WebSphere Business
Integration Server Express, entre em contato com o Suporte ao Cliente IBM on-line
ou através do telefone:

* Visite o Web site de suporte técnico do IBM WebSphere Business Integration
Server Express, no endereco
[http: / /www.ibm.com /software /integration /websphere /support /|

* Entre em contato com o suporte do IBM WebSphere Business Integration Server
Express support nos Estados Unidos ou Canada pelo telefone 1-800-IBM-SERV.
Para todos os outros paises, acesse
[http:/ /techsupport.services.ibm.com/guides/contacts.html|para encontrar o
nimero de telefone para sua regido.

© Copyright IBM Corp. 2004 1
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Capitulo 2. Validando Sua Instalacao do Windows

Este capitulo descreve como utilizar as amostras SystemTest para validar o sistema
ap6s instalar a edicdo para Windows do produto IBM® WebSphere® Business
Integration Server Express V4.3.1.

Nota: Assume-se que vocé instalou a edigdo para Windows do produto IBM
WebSphere Business Integration Server Express e que instalou o componente
Samples a partir da visualizagdo Install Samples durante a instala¢ao, que
instala as amostras SystemTest. Caso ainda ndo tenha instalado o produto
IBM WebSphere Business Integration Server Express e as amostras
SystemTest, consulte a publicacdo WebSphere Business Integration Server
Express Installation Guide for Windows.

Antes de utilizar as amostras, conforme descrito em “Utilizando o Test Connector
para Visualizar Dados de Neg6cios Sendo Processados” e “Utilizando o Adaptador
para JText para Processar Arquivos de Texto Através do Sistema”, serd necessario
iniciar o InterChange Server Express, iniciar o System Manager e conectar o
InterChange Server a ele, registrar uma instancia do InterChange Server Express e
assegurar que todos os componentes necessarios estejam funcionando
corretamente.

Este capitulo inclui as seguintes se¢des:

+ |“Plataformas Windows Suportadas”]

* [“Iniciando o InterChange Server Express” na pagina 4|

+ |“Iniciando o System Manager” na pagina 4|

+ |“Registrando uma Instancia do InterChange Server Express” na pagina 4|

* [“Verificando se Todos os Componentes Necessarios Estdo Funcionando|
Corretamente” na pagina 4|

« [“Utilizando o Test Connector para Visualizar Dados de Negdcios” na pagina 5|

« |"Utilizando o Adaptador para JText para Processar Arquivos de Texto” nal
agina 9

* [“Proxima Etapa a Ser Executada” na pagina 11|

Nota: Caso ja tenha iniciado o InterChange Server Express e o System Manager, e
tiver registrado uma instancia do InterChange Server Express, comece pela
secdo|”Verificando se Todos os Componentes Necessarios Estio Funcionandq
[Corretamente” na pagina 4]

Plataformas Windows Suportadas

O WebSphere Business Integration Server Express pode ser instalado no Windows
2000, Windows XP e Windows 2003. No entanto, existem diferencas importantes
entre essas versdes do Windows no que diz respeito a suporte de componente do
produtos e opg¢des de menu do Windows.

Informacdes Importantes sobre a Plataforma Windows

* As instrugdes fornecidas neste documento sdo baseadas em uma instalagdo IBM
WebSphere Business Integration Server Express no Windows 2000.
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Se estiver executando o IBM WebSphere Business Integration Server Express em
uma maquina do Windows XP, algumas das opgdes de inicializacdo e de menus
podem ser ligeiramente diferentes do que as opgdes mostradas nestas instrugoes.
Leve estas pequenas diferencas em consideragdo ao seguir as instrugdes
fornecidas neste documento para validar seus apods instalar a edigdo para
Windows do produto IBM® WebSphere®™® Business Integration Server Express
V4.3.1.

As ferramentas do IBM WebSphere Business Integration Server Express ndo sdao
suportadas no Windows 2003, exceto por: Failed Event Manager e System
Monitor. Como apenas o InterChange Server Express, os adaptadores (apenas no
modo de produgdo), Failed Event Manager e System Monitor sdo suportados,
serd necessdrio executar o System Manager em uma maquina dedicada com
Windows 2000 ou Windows XP.

Iniciando o InterChange Server Express

Para iniciar o InterChange Server Express, clique em Iniciar > Programas > IBM
WebSphere Business Integration Express > InterChange Server Express. O
InterChange Server Express inicia o Persistent Naming Server automaticamente.

Iniciando o System Manager

Aps iniciar o InterChange Server Express, inicie o WebSphere Workbench e o
System Manager.

Clique em Iniciar > Programas > IBM WebSphere Business Integration Express >
Toolset Express > Administrative > System Manager.

Para obter informagdes sobre o System Manager, consulte a publicagdo System
Implementation Guide.

Registrando uma Instéancia do InterChange Server Express

Apbs iniciar o System Manager, registre uma instancia do InterChange Server
Express.

1.

SIS EE NN

Clique com o botado direito em InterChange Server Instances na visualizagdo
“InterChange Server Component Management” e, em seguida, clique em
Register Server.

Digite WebSphereICS no campo “Server name”.
Digite admin no campo “User name”.

Digite null no campo “Password”.

Clique em Save User ID and Password.

Clique em OK.

Verificando se Todos os Componentes Necessarios Estao
Funcionando Corretamente

Ap6s iniciar o System Manager, verifique se todos os objetos do conector e de
colaboragdo estdo funcionando corretamente.

1.
2.

Expanda a instancia do servidor WebSphereICS.

Expanda a pasta Connectors. Cada conector ativo possui um icone de seta na cor
verde exibido ao seu lado. Verifique se todos conectores a seguir estao ativos
(marcados por uma seta na cor verde):
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e DestinationConnector
e SourceConnector
* SystemTestConnector

3. Se um conector ndo estiver ativo, clique com o botao direito do mouse sobre ele
e clique em Start connector_name no menu de contexto.

4. Expanda a pasta Collaboration Objects. Cada objeto de colaboragdo ativo
possui um icone de seta em verde exibido ao lado do objeto. Verifique se todos
os objetos de colaboragdo a seguir estdo ativos (marcados por um icone de seta
na cor verde).

* CustomerSynchronization_SourceToDestination
 SystemTestObject

5. Se um conector néo estiver ativo, clique com o botao direito do mouse sobre ele
e, em seguida, clique em Start collaboration_name no menu de contexto.

Utilizando o Test Connector para Visualizar Dados de Negodcios

Test Connector é uma interface grafica que apresenta a estrutura de um objeto de
negocios disposta em tabelas. Os conectores trocam dados com aplicativos através
de légica de negoécios e dessa maneira ndo possuem uma interface grafica. O Test
Connector emula conectores utilizando uma visualizagdo grafica, tornando mais
facil compreender a fungdo de um conector em uma interface, ao mesmo tempo
removendo a complexidade da execugdo dos conectores em si.

O objeto de colaboragdo CustomerSynchronization_SourceToDestination testa o
sistema IBM WebSphere Business Integration Server Express enviando objetos de
negocios de uma instancia do Test Connector para outra. O objeto de negdcios
Customer é simples em vez de hierdrquico. Ele ndo contém nenhum outro objeto
de negocios. O gabarito de colaboracdo CustomerSynchronization envia objetos de
negoécios - enviados pelo conector de origem na interface - para o conector de
destino, e ndo aplica uma légica de negocios digna de observacdo. As defini¢des de
SourceConnector e DestinationConnector representam o componente do servidor
de um conector. Elas ndo representam conectores executdveis. Essas defini¢oes sdo
suficientes para validar os subsistemas do IBM WebSphere Business Integration
Server Express.

As instrugdes a seguir utilizam o Test Connector para emular os conectores que
trocam dados no sistema IBM WebSphere Business Integration Server Express.

Nota: Essas instrucdes assumem que vocé iniciou o [InterChange Server Express| e
0 [System Manager/ e que verificou se os |conectores de teste e objetos def

[colaboragao estao ativos.

1. Clique em Iniciar > Programas > IBM WebSphere Business Integration
Express > Toolset > Development > Test Connector para iniciar o Test
Connector.

2. Clique em File > Create/Select Profile na barra de menus do “Test
Connector”.

3. Clique para selecionar o perfil SourceConnector e, em seguida, clique em OK.
O dialogo “Connector Profile” é mostrado abaixo, juntamente com o perfil
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4.

6.

6 Guia de Inicializacdo Répida

“SourceConnector” selecionado.

Connector Profile x|

Fil= Edit

%‘ﬂ'lm :|

onnector | Server
SoupceConneckar \ebSphereICS

DestinationConnector WehspheraICs

| ok Il Cancel I

Clique em File > Connect na barra de menus do “Test Connector”. Esta acdo
conecta a instancia atual do Test Connector com o perfil “SourceConnector”
carregado no servidor.

Repita as etapas|l|a Elpara iniciar outra instancia do Test Connector.
Especifique o perfil DestinationConnector em vez de SourceConnector na
etapa E O dialogo “Connector Profile” é mostrado abaixo, com o perfil
DestinationConnector selecionado.

Connector Profile x|
File Edit

%‘*l@ﬂ :|

Connector | Server | Configuration File |
SourceConneckar \WwebSphereICS CAIBMWebSphereServer. ..

DestinationConnector WehSphereICS CAIBMYWebSphereServer, .

I Ok ” Cancel I

Clique em File > Connect na barra de menus do “Test Connector”. Esta agao
conecta a instancia atual do Test Connector com o perfil DestinationConnector
carregado no servidor.

Na instancia do Test Connector que possui o perfil SourceConnector
carregado, clique em Edit > Load BO na barra de menus.



8. No dialogo “Open”, clique em \ProductDir \Samples\SystemTest e, em
seguida, clique para selecionar a pasta Customer.bo.

O dialogo “Open” é mostrado abaixo.

x| = @ ek E-

_ldata
[:I repositary

Customer,bo

File name: I j Cpen I
Files of type: IElusiness Chjects* ha) j Cancel |
g

9. Clique em Open para abrir o arquivo Customer.bo e exibir o didlogo “New
Instance”.

10. Digite Customer_0 no campo “Enter Name” e, em seguida, clique em OK. O

dialogo “New Instance”, com Customer_0 digitado no campo “Enter Name”, é
mostrado abaixo.

New Instance x|

Enter MNanne Custl:umer_lil|

0 4 Cancel I

Capitulo 2. Validando Sua Instalacio do Windows 7



11. Observe os valores como, por exemplo, FirstName, String, Tom, nos campos
do objeto de negdcios Customer, conforme mostrado abaixo.

Marne | Type | Yalue |
Customerld Skring 1000324
FirstMarme Skring Torm
LastMarme Skring Barrymore
Skatus Skring Active
CreatedOnD,..  String 10/09f2003
OhjectEventId  String SourceConne. ..

12. Clique em Request > Send na barra de menus para enviar o objeto de
negocios.

13. Direcione o foco para a instancia do Test Connector que possui o perfil
“DestinationConnector” carregado. Se o painel “BO Request List” contiver
Customer.Create, conforme mostrado abaixo, o objeto de negdcios Customer
foi recebido.

B Request Lisk
Customer, Create
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14. Dé um clique duplo no evento Customer.create para visualiza-lo como um
objeto de negdcios de resposta. O didlogo “Response BO” é mostrado abaixo.

i Response BO ﬂ
7| &

BO Twpe I Customer
erb: ICreate 'I BOLDcaIe:I 'I

Mare | Tyvpe | Walue |
CustamerId Skring 1000324
FirskMane Skring Tarm
LastMame Skring Earrymare
Status Skring Active
CreatedOnD... String 10/09/2003
ObjectEventId  String SourceCanne. ..

Cancel |

15. Opcional: Dé um clique duplo em cada um dos campos para editar os dados
da mesma maneira em que um aplicativo de destino geralmente designa seus
proprios valores para eventos por ele processados. Clique em OK ap6s
terminar de editar os campos.

16. Clique em Request > Reply > Success na barra de menus para simular que o
aplicativos de destino processou o objeto de negdcios com sucesso e que o
devolveu para o InterChange Server Express.

17. Quando tiver terminado de enviar e responder a eventos, clique em File >
Exit na barra de menus do “Test Connector” e, em seguida, clique em Yes
quando solicitado que vocé encerre o Test Connector.

Utilizando o Adaptador para JText para Processar Arquivos de Texto

O Adaptador para o conector JText pode converter dados de objetos de negécios
em arquivos de texto, e arquivos de texto em dados de objeto, o que permite que
ele troque objetos de negécios entre o InterChange Server Express e aplicativos
baseados em arquivo, como mainframes. Embora muitos aplicativos gerenciem
seus dados de negdcios através de interface de programacdo de aplicativos, alguns
ndo seguem esse caminho. Praticamente todos os aplicativos, no entanto, sdo
capazes de processar arquivos de texto, o que torna o Adaptador para JText um
conhecido e poderoso componente de integracao.

O objeto de colaboragdo SystemTestObject troca dados utilizando uma instancia do
Adaptador para JText. Esta instancia é chamada de SystemTestConnector nesta
amostra de SystemTest. Esta amostra ndo representa uma interface de integragdo
tipica, uma vez que a troca de dados do Enterprise ocorrem entre aplicativos
separados. No entanto, ela fornece uma forma independente de aplicativos para
validar a maioria dos tipos de componentes geralmente envolvidos em uma troca
de servidores do IBM WebSphere Business Integration Server Express.

O SystemTestConnector executa polls no diretério de dados na pasta
\\Samples\System da instalacdo do IBM WebSphere Business Integration Server
Express. Esta pasta de instalagdo contém a pasta Employee.in, que contém varios
registros de uma entidade de negécios Employee.

Capitulo 2. Validando Sua Instalagio do Windows 9



Os dados a seguir representam um tnico registro deste tipo:
* BusinessObject = Employee

* Verb = Create

* AttributeCount = 10

* Employeeld = 14963840

* FirstName = Frank

* LastName = Jones

* SocialSecurityNumber = 142-72-4050
 Salary = 15.00

* Hours = 40

* Comments = Hired for chip design initiative
* Revenue = 1000000

* PhoneNumber = 744-289-5848

* ObjectEventld = 0123456789

Este tipo de registro é conhecido como par nome/valor, delimitado. Nomes de
metadados, como Employeeld, identificam os dados que representam. Campos
individuais sdo identificados por caracteres especiais como retornos de paragrafo.
Registros individuais sdo identificados por caracteres especiais, como caracteres de
ponto-e-virgula.

O conector JText processa o arquivo Employee.in, convertendo os registros contidos
dentro dele para objetos de negdcios e, em seguida, envia esses objetos de negdcios
para o InterChange Server Express. Os objetos de negdcios sdo processados por
uma colaboracdo, que aplica uma pequena quantidade de légica de negécios nos
objetos. A colaboragdo envia os objetos de volta para SystemTestConnector, que
converte cada objeto de negdcios em um arquivo na pasta de dados.
SystemTestConnector utiliza a mesma pasta de dados para executar polls para
novos eventos e para realizar a saida dos objetos de negécios por ele processados.
SystemTestConnector processa sua prépria saida recursivamente, fornecendo um
fluxo consistente de dados através do sistema.

O modelo de colaboragdo SystemTest, a partir do qual os objetos de colaboracao
sdo baseados, foi projetado para tentar uma operagdo Java de formatacdo de
numeros ilegal em um campo em alguns dos objetos de negdcios processados pela
colaboracdo. Esta operagdo ilegal gera fluxos com falha para que vocé possa
utilizar o Flow Manager para fazer experimentos de resolugdo de falhas no
sistema. Para obter mais informagdes sobre o Flow Manager, consulte a publicagdo
System Administration Guide.

As instrugdes a seguir utilizar o Adaptador para JText para processar arquivos de
texto através de um par de interfaces no sistema.

Nota: Essas instrucdes assumem que vocé iniciou o IInterChange Server Express| e
0 [System Manager| e que verificou se os fconectores de teste e objetos del

colaboracdo| estdo ativos.

1. Na visualizagdo InterChange Server Component Management no System
Manager, clique com o botdo direito no objeto de colaboragao
SystemTestObject e, em seguida, clique em Statistics na barra de menus para
abrir a visualizacdo “Statistics”.
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Nota: A visualizagdo “Statistics” mostra informagdes sobre os eventos
processados por uma colaboragdo. As informagdes contidas nesta
visualiza¢do sdo tteis quando vocé estiver testando uma interface de
processos de negocios.

2. Clique em Iniciar > Programas > IBM WebSphere Business Integration
Express > Samples > System Test > Run SystemTest Sample para executar o
arquivo de lote de amostra SystemTest. Este arquivo iniciar JTextConnector e
copia um arquivo contendo dados de exemplo na pasta em que o conector
executa polls.

As informagoes exibidas dentro da janela de console da amostra SystemTest sao
deslocadas rapidamente conforme o JTextConnector é iniciado e, em seguida,
executa polls e processa eventos. Para ler as informagdes armazenadas em log,
clique na janela do console para marca-las, que ird pausar o processo.

3. Pressione Enter para desmarcar a janela do console, que ira reiniciar o processo.

4. Se a janela do “System Manager” ndo estiver maximizada, clique com o botdo
direito na barra de titulo da janela do “System Manager” e, em seguida, clique
em Maximize no menu de contexto para expandi-la completamente.

5. Na visualizacdo Statistics, que vocé abriu anteriormente para o objeto de
colaboragdo SystemTestObject no System Manager, exibe os contadores para o
nimero total de eventos processados, quantos eventos foram bem-sucedidos e
quantos eventos sofreram falhas. A interface foi projetada para ocasionalmente
causar falhas em um evento, para que vocé possa visualizar tanto fluxos com
falhas como fluxos bem-sucedidos.

6. Abra a pasta \\IBM\WebSphereServer\Samples\SystemTest\data, o caminho de
instalagdo padrdo para o IBM WebSphere Business Integration Server Express
em sua mdaquina, para visualizar os arquivos criados pelo conector conforme
ele processa os dados.

7. Apbs permitir que a interface seja executada por varios minutos, clique com o
botdo direito em SystemTestConnector na visualizacdo InterChange Server
Component Management no System Manager e, em seguida, clique em Shut
Down SystemTestConnector.

Préoxima Etapa a Ser Executada

Apods completar as instrugdes fornecidas neste capitulo, vocé acaba de verificar se o
InterChange Server Express foi iniciado e se os principais componentes do sistema
de integracdo podem implementar, iniciar, processar dados de negdécios, e se
podem ser encerrados. Isto indica que o sistema foi instalado corretamente e que
pode suportar desenvolvimento, testes e produgao subseqiientes.

Vocé deve, no entanto, limpar os objetos de negdcios em sua instalagdo antes de
utilizar o IBM WebSphere Business Integration Server Express. Va para o
(Capitulo 5, “Limpando Objetos de Negdcios”, na pagina 35 e siga as instrucoes
fornecidas para importagdo do arquivo de pacote BIA_BO_BaseCollabBOs.jar na
biblioteca de componentes de integragdo do WBIExpressLibrary e, em seguida,
implemente os objetos de negécios Customer e Employee no servidor.
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Capitulo 3. Validando Sua Instalacao do 0S/400

Este capitulo descreve como utilizar as amostras SystemTest para validar o sistema
ap6s instalar a edicao para OS/400 do produto IBM® WebSphere® Business
Integration Server Express V4.3.1.

Nota: Para as instrugdes neste capitulo, assume-se que a edi¢do do OS/400 para o
produto IBM WebSphere Business Integration Server Express foi instalada
com sucesso e que o componente Samples foi instalado a partir da tela
Install Samples durante a instalagdo que instalar as amostras SystemTest.
Caso ainda néo tenha instalado o produto IBM WebSphere Business
Integration Server Express e as amostras SystemTest, consulte a publicacao
WebSphere Business Integration Server Express Installation Guide for OS/400.

Antes de utilizar as amostras, conforme descrito em “Utilizando o Test Connector
para Visualizar Dados de Neg6cios Sendo Processados” e “Utilizando o Adaptador
para JText para Processar Arquivos de Texto Através do Sistema”, serd necessario
iniciar o InterChange Server Express, iniciar o System Manager e conectar o
InterChange Server a ele, registrar uma instancia do InterChange Server Express e
assegurar que todos os componentes necessarios estejam funcionando
corretamente.

Este capitulo inclui as seguintes se¢des:

+ |“Iniciando o InterChange Server Express”|

* [“Iniciando o System Manager” na pagina 14|

* |“Registrando uma Instancia do InterChange Server Express” na pagina 14|

* |“Verificando se Todos os Componentes Necessarios Estio Funcionando|
Corretamente” na pagina 14]

« [“Utilizando o Test Connector para Visualizar Dados de Negécios” na pagina 15|

+ |“Utilizando o Adaptador para JText para Processar Arquivos de Texto” nal
[pdgina 18|

* [“Préxima Etapa a Ser Executada” na pagina 11|

Nota: Caso ja tenha iniciado o InterChange Server Express e o System Manager, e
tiver registrado uma instancia do InterChange Server Express, comece pela
secdo [“Verificando se Todos os Componentes Necessérios Estdo Funcionandq
[Corretamente” na pagina 14]

Iniciando o InterChange Server Express

Caso tenha instalado o WebSphere Business Integration Console, inicie o servidor
utilizando o console OS/400 fornecido no cliente Windows.

1. Clique em Iniciar > Programas > IBM WebSphere Business Integration
Console > Console.

2. Digite as informagdes sobre o OS/400, nome do sistema ou endereco IP, e perfil
de usuario e senha.

Importante: O perfil de usudrio deve possuir autoridade especial *JOBCTL.
3. Clique em Start Server, proximo a instancia QWBIDFT.
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Caso néo tenha instalado o WebSphere Business Integration Console, inicie o
“sub-sistema QWBISVR43” em seu sistema OS/400 executando:

* o comando STRSBS SBSD(QWBISVR43/QWBISVR43) CL
ou

* o script submit_ics_server.sh.

Nota: Apés instalar o IBM WebSphere Business Integration Server Express, o
sub-sistema qwbisvr43 estara ativado por padrdo. Ao executar o comando
STRSBS, o sistema lhe dira se o sub-sistema ja estd ativado. Caso esteja, a
instancia do servidor QWBIDFT pode ndo ser iniciada pois ela ja esta
ativada. Como resultado, pode ser necessario iniciar o QWBIDFT através do:

e console
ou

* script submit_ics_server.sh QWBIDFT

Iniciando o System Manager

Apbs iniciar o InterChange Server Express, inicie o0 WebSphere Workbench e o
System Manager.

Clique em Iniciar > Programas > IBM WebSphere Business Integration Express >
Toolset Express > Administrative > System Manager para iniciar o WebSphere
Workbench.

Para obter informagdes sobre o System Manager, consulte a publicagdo System
Implementation Guide.

Registrando uma Instéancia do InterChange Server Express

Ap6s iniciar o System Manager, registre uma instancia do InterChange Server
Express.

1. Clique em Window > Open Perspective > Other na barra de menus do
Workbench do WebSphere.

2. Dé um clique duplo no System Manager.

w

Clique com o botao direito em InterChange Server Instances na visualizagdo
“InterChange Server Component Management” e, em seguida, clique em
Register Server.

Digite QWBIDFT no campo “Server name”.
Digite admin no campo “User name”.
Digite null no campo “Password”.

Clique em Save User ID and Password.
Clique em OK.

© N o oA

Verificando se Todos os Componentes Necessarios Estao
Funcionando Corretamente

Ap6s iniciar o System Manager, verifique se todos os objetos do conector e de
colaboragéo estdo funcionando corretamente.

1. Expanda instancia do servidor QWBIDFT.

2. Expanda a pasta Connectors. Cada conector ativo possui um icone de seta na cor
verde exibido ao seu lado. Verifique se todos conectores a seguir estdo ativos
(marcados por uma seta na cor verde):
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e DestinationConnector
e SourceConnector
* SystemTestConnector

3. Se um conector ndo estiver ativo, clique com o botao direito do mouse sobre ele
e clique em Start connector_name no menu de contexto.

4. Expanda a pasta “Collaboration Objects”. Cada objeto de colaboragéo ativo
possui um icone de seta em verde exibido ao lado do objeto. Verifique se todos
os objetos de colaboragdo a seguir estdo ativos (marcados por um icone de seta
na cor verde).

* CustomerSynchronization_SourceToDestination
 SystemTestObject

5. Se uma colaborac¢do ndo estiver ativa, clique com o botdo direito do mouse
sobre ela, em seguida, clique em Start collaboration_name no menu de contexto.

Utilizando o Test Connector para Visualizar Dados de Negodcios

Test Connector é uma interface grafica que apresenta a estrutura de um objeto de
negocios disposta em tabelas. Os conectores trocam dados com aplicativos através
de légica de negoécios e dessa maneira ndo possuem uma interface grafica. O Test
Connector emula conectores utilizando uma visualizagdo grafica, tornando mais
facil compreender a fungdo de um conector em uma interface, ao mesmo tempo
removendo a complexidade da execugdo dos conectores em si.

O objeto de colaboragdo CustomerSynchronization_SourceToDestination testa o
sistema IBM WebSphere Business Integration Server Express, enviando objetos de
negocios de uma instancia do Test Connector para outra. O objeto de negdcios
Customer é simples em vez de hierdrquico. Ele ndo contém nenhum outro objeto
de negocios. O gabarito de colaboracdo CustomerSynchronization envia objetos de
negoécios - enviados pelo conector de origem na interface - para o conector de
destino, e ndo aplica uma légica de negocios digna de observacdo. As defini¢des de
SourceConnector e DestinationConnector representam o componente do servidor
de um conector. Elas ndo representam conectores executdveis. Essas defini¢oes sdo
suficientes para validar os subsistemas do IBM WebSphere Business Integration
Server Express.

As instrugdes a seguir utilizam o Test Connector para emular os conectores que
trocam dados no sistema IBM WebSphere Business Integration Server Express.

Nota: Para estas instrucdes, assume-se que vocé iniciou o [InterChange Server
Express|e o [System Managet [registrou uma instancia do InterChange Server|
Express instance] e verificou se os|conectores e objetos de colaboracio| estao
ativos.

1. Mapeie uma unidade de rede para seu sistema OS/400
(\\OS400system\root).

2. Clique em Iniciar > Programas > IBM WebSphere Business Integration
Express > Toolset Express > Development > Test Connector para iniciar o
Test Connector.

3. Clique em File > Create/Select Profile na barra de menus do “Test
Connector”.

4. Selecione File > New Profile na barra de menus do “Connector Profile”.

5. Clique em Browse e, em seguida, navegue até a unidade mapeada definida na
etapa[l} Navegue até o diretério \QIBM\UserData\WBIServer43\QWBIDFT\,
clique para selecionar o arquivo “InterchangeSystem.cfg” e clique em Open.
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10.

11.

12.

13.

14.

Nota: Caso esteja fazendo isto para uma instancia criada com o script
create_instance.sh, utilize esse nome de instincia em vez de QWBIDFT.

No campo “Connector Name”, digite SourceConnector.

No campo “Server”, digite o nome do servidor QWBIDFT ou o nome
utilizado com o script create_instance.sh.

No campo “Password”, digite a senha para o usudrio administrativo ICS. Caso
ndo tenha alterado esta senha apés a instalagdo, a senha sera null.

Clique para selecionar o perfil SourceConnector e, em seguida, clique em OK.
O diédlogo “Connector Profile” é mostrado abaixo com o perfil
“SourceConnector” selecionado.

Connector Profile

File Edit

|2 ]

C k

EoirceC onnector iebspheraics CiEMiwebSphereserver .. |
DestinationConnector WebSpherelCS CHATEMyWebSphereServer ...
SourceConnectar QWEIDFT O \QIBM\ UserDatal WwBIS. ..

Clique em File > Connect na barra de menus do “Test Connector”. Esta agao
conecta a instancia atual do Test Connector com o perfil SourceConnector
carregado no servidor.

Repita as etapas a Elpara iniciar outra instancia do Test

Connector. Utilize DestinationConnector em vez de SourceConnector nas
etapas El e

Clique em File > Connect na barra de menus do “Test Connector”. Esta acdo
conecta a instancia atual do Test Connector com o perfil DestinationConnector
carregado no servidor.

Na instancia do Test Connector que possui o perfil SourceConnector
carregado, clique em Edit > Load BO na barra de menus.

No didlogo “Open”, navegue até
\QIBM\UserData\WBIServer43\QWBIDFT\Samples\SystemTest\ em sua
unidade mapeada, e clique para selecionar a pasta Customer.bo. O didlogo
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“Open” serd mostrado abaixo.

File name: IEuslomer.bn j Open I
Files of type: | Buginess Objects(* bo) :I Cancel |
A

15. Clique em Open para abrir o arquivo Customer.bo e exibir o didlogo “New
Instance”.

16. Digite Customer_0 no campo “Enter Name” e, em seguida, clique em OK.

17. Observe os valores como, por exemplo, FirstName, String, Tom, nos campos
do objeto de negdcios Customer, conforme mostrado abaixo.

Tame | Type | alue |
Customerld Skring 1000324
FirstMame Skring Tam
LastMarme Skring Barrymore
Skakus Skring Ackive
CreatedOnD...  String 100912003
OhjectEventId  String SourceConne. ..

18. Clique em Request > Send na barra de menus para enviar o objeto de
negocios.

19. Direcione o foco para a instancia do Test Connector que possui o perfil
DestinationConnector carregado. Se o painel “BO Request List” contiver
Customer.Create, conforme mostrado abaixo, o objeto de negdcios Customer
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foi recebido.

B Request Lisk
Customer, Create

20. Dé um clique duplo no evento “Customer.create” para visualiza-lo como um
objeto de negdcios de resposta. O didlogo Response BO é mostrado abaixo.

i Response BO ﬂ
& 7| &

BO Twpe I Customer
erb: ICreate 'I BOLDcaIe:I 'I

Tarne | Type | Yalue |
CustamerId Skring 1000324
FirskMane Skring Tarm
LastMame Skring Earrymare
Status Skring Active
CreatedOnD... String 10/09/2003
ObjectEventId  String SourceCanne. ..

Al cancel |

21. Opcional: Dé um clique duplo em cada um dos campos para editar os dados
da mesma maneira em que um aplicativo de destino geralmente designa seus
proprios valores para eventos por ele processados. Clique em OK ap6s
terminar de editar os campos.

22. Clique em Request > Reply > Success na barra de menus para simular que o
aplicativos de destino processou o objeto de negécios com sucesso e que o
devolveu para o InterChange Server Express.

23. Ap0s terminar de enviar e responder aos eventos, clique em File > Exit na
barra de menus do Test Connector e, em seguida, clique em Yes quando for
solicitado que vocé encerre o Test Connector.

Utilizando o Adaptador para JText para Processar Arquivos de Texto

O Adaptador para o conector JText pode converter dados de objetos de negécios
em arquivos de texto, e arquivos de texto em dados de objeto, o que permite que
ele troque objetos de negodcios entre o InterChange Server Express e aplicativos
baseados em arquivo, como mainframes. Embora muitos aplicativos gerenciem
seus dados de negdcios através de interface de programagao de aplicativos, alguns
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ndo seguem esse caminho. Praticamente todos os aplicativos, no entanto, sdo
capazes de processar arquivos de texto, o que torna o Adaptador para JText um
conhecido e poderoso componente de integracao.

O objeto de colaboragdo SystemTestObject troca dados utilizando uma instancia do
Adaptador para JText. Esta instancia é chamada de SystemTestConnector nesta
amostra de SystemTest. Esta amostra nao representa uma interface de integracao
tipica, uma vez que a troca de dados do Enterprise ocorre entre aplicativos
separados. No entanto, ela fornece uma forma independente de aplicativos para
validar a maioria dos tipos de componentes geralmente envolvidos em uma troca
de servidores do IBM WebSphere Business Integration Server Express.

O SystemTestConnector executa polls no diretério de dados na pasta
\\Samples\System da instalagdo do IBM WebSphere Business Integration Server
Express. Esta pasta de instalacdo contém a pasta Employee.in, que contém vérios
registros de uma entidade de negécios Employee.

Os dados a seguir representam um tdnico registro deste tipo:
* BusinessObject = Employee

* Verb = Create

* AttributeCount = 10

* Employeeld = 14963840

* FirstName = Frank

* LastName = Jones

* SocialSecurityNumber = 142-72-4050

* Salary = 15.00

* Hours = 40

¢ Comments = Hired for chip design initiative
* Revenue = 1000000

* PhoneNumber = 744-289-5848

* ObjectEventld = 0123456789

Este tipo de registro é conhecido como par nome/valor, delimitado. Nomes de
metadados, como Employeeld, identificam os dados que representam. Campos
individuais sdo identificados por caracteres especiais como retornos de paragrafo.
Registros individuais sdo identificados por caracteres especiais, como caracteres de
ponto-e-virgula.

O conector JText processa o arquivo Employee.in, convertendo os registros contidos
dentro dele para objetos de negdcios e, em seguida, envia esses objetos de negdcios
para o InterChange Server Express. Os objetos de negdcios sdo processados por
uma colaboracdo, que aplica uma pequena quantidade de l6gica de negdcios nos
objetos. A colaboracdo envia os objetos de volta para SystemTestConnector, que
converte cada objeto de negdcios em um arquivo na pasta de dados.
SystemTestConnector utiliza a mesma pasta de dados para executar polls para
novos eventos e para realizar a saida dos objetos de negécios por ele processados.
SystemTestConnector processa sua propria saida recursivamente, fornecendo um
fluxo consistente de dados através do sistema.

O modelo de colaboragdo SystemTest, a partir do qual os objetos de colaboracao
sdo baseados, foi projetado para tentar uma operagdo Java de formatacdo de
numeros ilegal em um campo em alguns dos objetos de negdcios processados pela
colaboragéo. Esta operacéo ilegal gera fluxos com falha para que vocé possa
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utilizar o Flow Manager para experimentar com a resolucdo de falhas no sistema.
Para obter mais informagdes sobre o Flow Manager, consulte a publicacdo Systemn
Administration Guide.

As instrugdes a seguir utilizar o Adaptador para JText para processar arquivos de
texto através de um par de interfaces no sistema.

Nota: Para estas instrucdes, assume-se que vocé iniciou o IInterChange Served
Express|e o [System Managed |registrou uma instancia do InterChange Server|
Express instance] e verificou se os [conectores e objetos de colaboracéol estdo
ativos.

1. Na visualizagdo InterChange Server Component Management do System
Manager, clique com o botdo direito no objeto
CustomerSynchronization_SourceToDestination::CustomerSynchronization
collaboration e, em seguida, clique em Statistics na barra de menus para abrir
a visualizagdo Statistics.

Nota: A visualizacido Statistics mostra informacoes sobre os eventos
processados por uma colaboracdo. As informacdes contidas nesta
visualizagdo sdo tteis quando vocé estiver testando uma interface de
processos de negdcios.

2. Repita a etapa [lf acima para o objeto “SystemTestObject::SystemTest
collaboration”.

3. A partir da entrada de comandos do “OS/400, execute CL command QSH. Em
seguida, digite /QIBM/UserData/WBIServer43/QWBIDFT/Samples/SystemTest/
start_SystemTest.sh para executar um script de shell. O script shell inicia
JTextConnector, e copia um arquivo de dados de exemplo no diretério no qual
o conector executa polls.

As informagoes exibidas na janela do console “SystemTest sample” sdo
deslocadas rapidamente conforme o JTextConnector é iniciado; em seguida,
polls sdo executados e eventos processados.

4. Se ajanela do System Manager ndo for maximizada, clique com o botao direito
na barra do titulo da janela do System Manager e, em seguida, clique em
Maximize no menu de contexto, caso essa opgao esteja disponivel. Se o System
Manager ndo estiver maximizado, o grafico citado na préxima etapa ndo estard
inicialmente na visualizagéo.

5. A tela Statistics, que vocé abriu para o objeto de colaboragao SystemTestObject
no System Manager, exibe os contadores para o niimero total de eventos
processados, quantos eventos foram bem-sucedidos, e quantos eventos sofreram
falhas. A interface foi projetada para ocasionalmente causar falhas em um
evento, para que vocé possa visualizar tanto fluxos com falhas como fluxos
bem-sucedidos.

6. Acesse a pasta
/QIBM/UserData/WBIServer43/QWBIDFT /Samples/SystemTest/data em sua
instalacdo para visualizar os arquivos criados pelo conector conforme ele
processa os dados.

7. Apbs permitir que a interface seja executado por vérios minutos, clique com o
botdo direito em SystemTestConnector na visualizagdo InterChange Server
Component Management no System Manager e, em seguida, clique em Shut
Down SystemTestConnector.
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Préoxima Etapa a Ser Executada

Apbs completar as instrugdes fornecidas neste capitulo, vocé acaba de verificar se o
InterChange Server Express foi iniciado e se os principais componentes do sistema
de integracdo podem implementar, iniciar, processar dados de negécios e se podem
ser encerrados. Isto indica que o sistema foi instalado corretamente e que pode
suportar desenvolvimento, testes e producdo subseqiientes.

Vocé deve, no entanto, limpar os objetos de negdcios em sua instalagdo antes de
utilizar o IBM WebSphere Business Integration Server Express. Va para o
(Capitulo 5, “Limpando Objetos de Negécios”, na pagina 35 e siga as instrucdes
fornecidas para importagao do arquivo de pacote BIA_BO_BaseCollabBOs.jar na
biblioteca de componentes de integragdo do WBIExpressLibrary e, em seguida,
implemente os objetos de negé6cios Customer e Employee no servidor.
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Capitulo 4. Validando Sua Instalacao do Linux

Este capitulo descreve como utilizar as amostras SystemTest para validar o sistema
ap6s instalar a edicao para Linux do produto IBM®™ WebSphere™ Business
Integration Server Express V4.3.1.

Nota: Este documento assume que vocé instalou a edicdo para Linux do produto
IBM WebSphere Business Integration Server Express com sucesso, e que
instalou o componente Samples na tela Install Samples durante a instalagao,
que ira instalar as amostras SystemTest. Caso ainda ndo tenha instalado o
produto IBM WebSphere Business Integration Server Express e as amostras
SystemTest, consulte a publicacdo WebSphere Business Integration Server
Express Installation Guide for Linux.

Antes de utilizar as amostras, conforme descrito em “Utilizando o Test Connector
para Visualizar Dados de Neg6cios Sendo Processados” e “Utilizando o Adaptador
para JText para Processar Arquivos de Texto Através do Sistema”, serd necessario
iniciar o InterChange Server Express, iniciar o System Manager e conectar o
InterChange Server a ele, registrar uma instancia do InterChange Server Express e
assegurar que todos os componentes necessarios estejam funcionando
corretamente.

Este capitulo inclui as seguintes se¢des:

+ |“Instalando o Toolset Express”

¢ [“Iniciando o InterChange Server Express” na pagina 26|

+ |“Iniciando o System Manager” na pagina 26|

+ |“Registrando uma Instancia do InterChange Server Express” na pagina 26|

* [“Verificando se Todos os Componentes Necessarios Estdo Funcionando|
Corretamente” na péagina 27

« |“Utilizando o Test Connector para Visualizar Dados de Negécios” na pagina 27|

« |"Utilizando o Adaptador para JText para Processar Arquivos de Texto” nal
[pagina 31|

* [“Préxima Etapa a Ser Executada” na pagina 34|

Nota: Caso vocé ja tenha instalado o Toolset Express, iniciado o InterChange
Server Express e o System Manager e registrado uma instancia do
InterChange Server Express, comece pela secio [“Verificando se Todos og
[Componentes Necessérios Estiao Funcionando Corretamente” na pagina 27

Instalando o Toolset Express

Antes de utilizar as amostras SystemTest para validar o sistema, serd necessario
instalar o Toolset Express no cliente Windows.

Durante o processo de instalacdo do Toolset Express, serd necessario especificar seu
endereco IP do InterChange Server Express. Navegue até o
arquivo%CROSSWORLDS%\bin\CWSharedEnv.bat e verifique a entrada
ORB_HOST=SERVER_HOST_IP para encontrar o endereco IP onde seu servidor
estd localizado.
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1. Em uma méquina cliente do Windows, dé um clique duplo em launchpad.exe
para iniciar o Launchpad.

Nota: As ferramentas de desenvolvimento estdo disponiveis apenas no
Windows 2000 e Windows XP. Caso deseje instalar o conjunto completo
de ferramentas, sera necessdrio instalar o Toolset Express no Windows
2000 ou Windows XP.

2. No painel “Welcome”, clique em Install Product. O “welcome panel” sera
mostrado abaixo.

i34 IBM WebSphere Business Integration Server Express Launchpad

IBM WebSphere Business Integration Server Express Plus ¥4.3.1

Welcome Welcome to the IBM WebSphere Business
Integration Server Express Launchpad

Install Product

IBM WebSphere Business Integration Server Express is a core component of IBIV
WebSphere Business Integration Server for process automation that manages multiple
discrete business applications as one. The IBM WebSphere Business Integration Server
sl e R ML Y Fapress Launchpad will help prepare your computer for the installation of the IBIM

WebSphere Business Integration Server Express product and then install the product.

@ The IBM logo and WehSphere are trademarks or registered trademarks of 1IBM Corporation in the US| ather countries, or both. AfF rights
resened 2004,

3. Na pégina “Install Server”, assegure-se que a caixa de opg¢des do InterChange
Server Express ndo esteja marcada e, em seguida, clique em Next.

4. Na péagina “Install Tools”, clique para selecionar as ferramentas
administrativas e as ferramentas de desenvolvimento e, em seguida, clique

z

em Next. O painel “Install Tools” é mostrado abaixo.

f@s IBM WebSphere Business Integration Server Express Launchpad

L LR 8 IBM WebSphere Business Integration Server Express Plus ¥4.3.1

Install Tools

Toolset Express can be installed to this machine. The following checkboxes have been
Install Product preselected to install the Administrative and Development Tools. Unselect these
checkboxes if you do not want to install Toolset Express components.
[# Admiristrative Tools @

Install Capacity Pack
W Developmert Tools &

@ The [BM logo and YWebSphere are trademarks or registered trademarks of IBM Corporstion in the US| other countries, or bath. AN rights
reserved 2004,

Next = et P |

5. Na pégina “Install Adapter”, assegure-se de que vocé nao tenha selecionado
nenhum adaptador e, em seguida, clique em Next.
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Importante: Caso tenha instalado o IBM WebSphere Business Integration
Express no Windows XP, pule esta etapa, pois a pagina “Install Adapter” nao
é exibida na instalacdo do Windows XP.

6. No painel “Install Samples”, assegure que as amostras ndo estejam
selecionada e clique em Next.

7. No painel “Software Prerequisites”, instale software de terceiros conforme
requerido. O painel “Software Prerequisites” é mostrado abaixo.

i3 IBM WebSphere Business Integration Server Express Launchpad

ST G IBM WebSphere Business Integration Server Express Plus ¥4.3.1

The IBM WebSphere Business Integration Server Express Plus Launchpad will help prepare
Install Product your computer for the installation of the IBM WebSphere Business Integration Server
Express Plus product and then install the product.

Install Capacity Pack

@ The IBM logo and WebSphere are trademarks of registered trademarks of IBM Corporation in the US| other courtries, or both. A rights

resened 2004,

Prerequisites

b IBM Java Development Kit 1.3.1_05 OK &
b IBM WehSphere MG 5.3.0.2 C5DOB Client OK
b IBM WehSphere Application Server - Express V5.1 OK
b Wieh Browser OK

Software Prerequisites

< Back [HEXI= Install Product |

8. Clique em Install Product para iniciar o instalador.

9. No painel “Software License Agreement”, aceite a licenca e clique em Next.
10. No painel “Destination”, especifique a pasta onde deseja instalar o Toolset

Express e clique em Next.

11. No painel “Naming Server”, especifique o endereco IP do servidor IBM
WebSphere Business Integration Server Express e clique em Next para iniciar a

instalacdo do Toolset Express. O painel “Name Server Configuration” é

mostrado abaixo.

2

t IBM WebSphere Business Integration Server Express Plus v4.3.1 Installer

Mame Server Configuration

‘fou have selacted to install the Toolset Express or Adapter components without the InterChange
Serer Express. Specify the IP address ofthe InterChange Server Express you wish to connectto.

InterChange Sener Express IP address {e.g. 32.108.230.121):
|202.112.58.200]

= Back MNext = Cancel
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12. Assim que a instalagdo for concluida, clique em Finish. O painel “finish
installation” sera mostrado abaixo.

i IBM WebSphere Buiess Integration Server Express Plus v4.3.1 Installer S B

Flease read the summary information below.

Please referto the First Steps document. You can access itvia the First Steps icon located in the Jalf
WeabSphare Sener Express Plusfolder in the start menus Programs folder,

The InstallShield Wizard has successfully installed 1BM YWebSphere Business Integration Server
Express Plusv4.3.1. Choose Finigh to exitthe wizard.

Iniciando o InterChange Server Express

Execute os seguintes scripts para iniciar o InterChange Server Express.
1. $cd/home/USER/IBM/WebSphereServer/bin or $cd/ProductDir/bin
2. $/ics_manager -start

Notas: Nos scripts mostrados acima:
* "$" é o prompt da linha de comandos do Linux.
e "cd” é um comando utilizado para mudar de diretdrio.

* "bin” é uma pasta dentro do diretério de instalagao do produto.

O InterChange Server Express inicia o Persistent Naming Server automaticamente.

Iniciando o System Manager

Apos iniciar o InterChange Server Express, inicie o WebSphere Workbench e o
System Manager.

No cliente Windows, clique em Iniciar > Programas > IBM WebSphere Business

Integration Express > Toolset Express > Administrative > System Manager para
iniciar o Workbench do WebSphere.

Para obter informagdes sobre o System Manager, consulte a publicagdo System
Implementation Guide.

Registrando uma Instancia do InterChange Server Express

Apobs iniciar o System Manager, registre o InterChange Server Express.
1. Verifique as seguintes configuracdes:
a. Assegure que o cliente Windows possa acessar o servidor de nomes
corretamente. Verifique se ORB_HOST esta definido corretamente no

arquivo Windows client CWSharedEnv.bat, da seguinte maneira: set
ORB_HOST=ip_address
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Nota: Como alternativa, vocé podera utilizar set ORB_HOST=smb-redhat
e, em seguida, incluir a linha ip_address smb-redhat no arquivo
%windir%\system32\drivers\etc\hosts.

b. Assegure que o servidores de nomes consiga recuperar o IP do servidor
Linux por nome. Navegue até o arquivo file/etc/hosts, abra-o e, em
seguida, procure por entradas parecidas com as seguintes linhas:

ip_address localhost.localdomain localhost
ip_address smb-redhat.cn.ibm.com smb-redhat

2. Clique com o botédo direito em InterChange Server Instances na visualizagdo
InterChange Server Component Management e, em seguida, clique em Register
Server.

Digite WebSphereICS no campo “Server name”.
Digite admin no campo “User name”.

Digite null no campo “Password”.

Clique em Save User ID and Password.

Clique em OK.

N oM~

Verificando se Todos os Componentes Necessarios Estao
Funcionando Corretamente

Apbs iniciar o System Manager, verifique se todos os objetos do conector e de
colaboracéo estdo funcionando corretamente.

1. Expanda a instancia do servidor WebSphereICS.

2. Expanda a pasta Connectors. Cada conector ativo possui um icone de seta na cor
verde exibido ao seu lado. Verifique se todos conectores a seguir estdo ativos
(marcados por uma seta na cor verde):

* DestinationConnector
e SourceConnector
* SystemTestConnector

3. Se uma colaboragdo ndo estiver ativa, clique com o botdo direito do mouse
sobre ela e, em seguida, clique em Start connector_name no menu de contexto.
4. Expanda a pasta Collaboration Objects. Cada objeto de colaboragdo ativo
possui um icone de seta em verde exibido ao lado do objeto. Verifique se todos
os objetos de colaboragdo a seguir estdo ativos (marcados por um icone de seta
na cor verde).
¢ CustomerSynchronization_SourceToDestination
* SystemTestObject

5. Se um conector ndo estiver ativo, clique com o botdo direito do mouse sobre ele
e, em seguida, clique em Start collaboration_name no menu de contexto.

Utilizando o Test Connector para Visualizar Dados de Negoécios

Test Connector é uma interface gréfica que apresenta a estrutura de um objeto de
negocios disposta em tabelas. Os conectores trocam dados com aplicativos através
de légica de negoécios e dessa maneira ndo possuem uma interface grafica. O Test
Connector emula conectores utilizando uma visualizagdo grafica, tornando mais
facil compreender a funcdo de um conector em uma interface, a0 mesmo tempo
removendo a complexidade da execucdo dos conectores em si.
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O objeto de colaboragdo CustomerSynchronization_SourceToDestination testa o
sistema IBM WebSphere Business Integration Server Express, enviando objetos de
negocios de uma instancia do Test Connector para outra. O objeto de negdcios
Customer é simples em vez de hierarquico. Ele ndo contém nenhuma outro objeto
de negocios. O gabarito de colaboragdo CustomerSynchronization envia objetos de
negoécios - enviados pelo conector de origem na interface - para o conector de
destino, e ndo aplica uma légica de negocios digna de observacdo. As defini¢des de
SourceConnector e DestinationConnector representam o componente do servidor
de um conector. Elas ndo representam conectores executdveis. Essas defini¢oes sdo
suficientes para validar os subsistemas do IBM WebSphere Business Integration
Server Express.

As instrugdes a seguir utilizam o Test Connector para emular os conectores que
trocam dados no sistema IBM WebSphere Business Integration Server Express.

Nota: Para estas instrucdes, presume-se que vocé iniciou o |InterChange Server|
Express} |System Manager} [registrou uma instancia do InterChange Server|
Express|e [verificou se os conectores de teste e objetos de colaboracio|estio
ativos.

1. Clique em Iniciar > Programas > IBM WebSphere Business Integration
Express > Development > Test Connector para iniciar o Test Connector.

2. Clique em File > Create/Select Profile na barra de menus do Test Connector.

3. Clique para selecionar o perfil SourceConnector e, em seguida, clique em OK.
O dialogo “Connector Profile” é mostrado abaixo com o perfil
SourceConnector selecionado.

Connector Profile ; x|

Fil=  Edit

%‘*lm :|

Connector | Server | Configuration File |
SourceConneckor WiebopherelCS C:1IEMiW ebSphereserver . .,

DestinationConnector WWwehSphereICS CAIBMYWebSphereServer. ..

I OF, ” Caniel I

4. Clique em File > Connect na barra de menus do “Test Connector”. Esta acdo
conecta a instancia atual do Test Connector com o perfil SourceConnector
carregado no servidor.

5. Repita as etapas|l|a para iniciar outra instancia do Test

Connector. Especifique o perfil DestinationConnector em vez de
SourceConnector na etapa[3l O didlogo “Connector Profile” é mostrado
abaixo, com o perfil DestinationConnector selecionado.
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Connector Profile ' |

File Edit

%1}-'?' % |

Connector | Setver | Configuration File |
SourceConneckar ‘WebSpherelZ5 CAIBMYWebSphereServer. ..

DestinationConnector herelCs CHIBMYwebSphereseryer, .,

Web's 1)

| ok II Cancel I

6. Clique em File > Connect na barra de menus do “Test Connector”. Esta acao
conecta a instancia atual do Test Connector com o perfil DestinationConnector
carregado no servidor.

7. Na instancia do Test Connector que possui o perfil SourceConnector
carregado, clique em Edit > Load BO na barra de menus.

8. No dialogo “Open”, acesse \ProductDir \Samples\SystemTest e, em seguida,
abra a pasta Customer.bo. O didlogo “Open” é mostrado abaixo.

21

_ldata
[:I repositary

Customer,bo

Dezktap

% oy
o

OCUMmEnts

File name: I j Cpen I
Files of type: IElusiness Chjects* ha) j Cancel |
g

9. Clique em Open para abrir o arquivo Customer.bo e exibir o didlogo “New
Instance”.

10. Digite Customer_0 no campo “Enter Name” e, em seguida, clique em OK. O
dialogo “New Instance”, com Customer_0 digitado no campo “Enter Name”, é
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mostrado abaixo.

New Instance El

Entet Mane Custumer_[l|

(0] 4 Cancel I

11. Observe os valores como, por exemplo, FirstName, String, Tom, nos campos
do objeto de negdcios Customer, conforme mostrado abaixo.

Tame | Type | alue |
CustomerId Skring 1000324
FirstMarme Skring Torm
LaskMame Skring Batryrmore
Skatus Skring Active
CreatedOnD...  String 1000912003
OhjectEventId  String SourceConne. ..

12. Clique em Request > Send na barra de menus para enviar o objeto de
negocios.

13. Direcione o foco para a instancia do Test Connector que possui o perfil
DestinationConnector carregado. Se o painel “BO Request List” contiver
Customer.Create, conforme mostrado abaixo, o objeto de negécios Customer
foi recebido.

B Request Lisk
Customer, Create
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14. Dé um clique duplo no evento Customer.create para visualiza-lo como um
objeto de negdcios de resposta. O didlogo “Response BO” é mostrado abaixo.

i Response BO ﬂ
& 7| &

BO Twpe I Customer
erb: ICreate 'I BOLDcaIe:I 'I

Mare | Tyvpe | Walue |
CustamerId Skring 1000324
FirskMane Skring Tarm
LastMame Skring Earrymare
Status Skring Active
CreatedOnD... String 10/09/2003
ObjectEventId  String SourceCanne. ..

Cancel |

15. Opcional: Dé um clique duplo em cada um dos campos para editar os dados
da mesma maneira em que um aplicativo de destino geralmente designa seus
proprios valores para eventos por ele processados. Clique em Ok quando tiver
concluido a edicdo dos campos.

16. Clique em Request > Reply > Success na barra de menus para simular que o
aplicativo de destino processou o objeto de negdcios com sucesso e que o
devolveu para o InterChange Server Express.

17. Ap6s terminar de enviar e responder aos eventos, clique em File > Exit na

barra de menus do Test Connector e, em seguida, clique em Yes quando for
solicitado que vocé encerre o Test Connector.

Utilizando o Adaptador para JText para Processar Arquivos de Texto

O Adaptador para o conector JText pode converter dados de objetos de negécios
em arquivos de texto, e arquivos de texto em dados de objeto, o que permite que
ele troque objetos de negécios entre o InterChange Server Express e aplicativos
baseados em arquivo, como mainframes. Embora muitos aplicativos gerenciem
seus dados de negdcios através de interface de programacdo de aplicativos, alguns
ndo seguem esse caminho. Praticamente todos os aplicativos, no entanto, sdo
capazes de processar arquivos de texto, o que torna o Adaptador para JText um
conhecido e poderoso componente de integracao.

O objeto de colaboragdo SystemTestObject troca dados utilizando uma instancia do
Adaptador para JText. Esta instancia é chamada de SystemTestConnector nesta
amostra de SystemTest. Esta amostra ndo representa uma interface de integragdo
tipica desde que o intercambio de dados corporativo ocorra entre aplicativos
separados. No entanto, ela fornece uma forma independente de aplicativos para
validar a maioria dos tipos de componentes geralmente envolvidos em uma troca
de servidores do IBM WebSphere Business Integration Server Express.

SystemTestConnector executa polls na pasta de dados dentro da pasta
/ProductDir/Samples/SystemTest da instalagdo do IBM WebSphere Business
Integration Server Express. Esta pasta de instalacdo contém a pasta Employee.in,
que contém vérios registros de uma entidade de negécios Employee.
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Os dados a seguir representam um tnico registro deste tipo:
* BusinessObject = Employee

* Verb = Create

* AttributeCount = 10

* Employeeld = 14963840

* FirstName = Frank

* LastName = Jones

* SocialSecurityNumber = 142-72-4050
 Salary = 15.00

* Hours = 40

* Comments = Hired for chip design initiative
* Revenue = 1000000

* PhoneNumber = 744-289-5848

* ObjectEventld = 0123456789

Este tipo de registro é conhecido como par nome/valor, delimitado. Nomes de
metadados, como Employeeld, identificam os dados que representam. Campos
individuais sdo identificados por caracteres especiais como retornos de paragrafo.
Registros individuais sdo identificados por caracteres especiais, como caracteres de
ponto-e-virgula.

O conector JText processa o arquivo Employee.in, convertendo os registros contidos
dentro dele para objetos de negdcios e, em seguida, envia esses objetos de negdcios
para o InterChange Server Express. Os objetos de negdcios sdo processados por
uma colaboracdo, que aplica uma pequena quantidade de légica de negécios nos
objetos. A colaboragdo envia os objetos de volta para SystemTestConnector, que
converte cada objeto de negdcios em um arquivo na pasta de dados.
SystemTestConnector utiliza a mesma pasta de dados para executar polls para
novos eventos e para realizar a saida dos objetos de negécios por ele processados.
SystemTestConnector processa sua prépria saida recursivamente, fornecendo um
fluxo consistente de dados através do sistema.

O modelo de colaboragdo SystemTest, a partir do qual os objetos de colaboracao
sdo baseados, foi projetado para tentar uma operagdo Java de formatacdo de
numeros ilegal em um campo em alguns dos objetos de negdcios processados pela
colaboracdo. Esta operagdo ilegal gera fluxos com falha para que vocé possa
utilizar o Flow Manager para experimentar com a resolucdo de falhas no sistema.
Para obter mais informagdes sobre o Flow Manager, consulte a publicacdo Systern
Administration Guide.

As instrugdes a seguir utilizar o Adaptador para JText para processar arquivos de
texto através de um par de interfaces no sistema.

Nota: Para estas instrucdes, assume-se que vocé iniciou o IInterChange Served
Express| [System Manager [registrou uma instancia do InterChange Server]
Express| e verificou que os [conectores de teste e objetos de colaboracad estdo
ativos.

1. Execute o arquivo shell /ProductDir/Samples/SystemTest/start_SystemTest.sh
shell no servidor Linux InterChange para iniciar o JTextConnector e copiar um
arquivo de dados de amostra na pasta em que polls sdo executados pelo
conector.
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As informagoes exibidas na janela do console “SystemTest sample” sdao
deslocadas rapidamente conforme o JTextConnector é iniciado; em seguida,
polls sdo executados e eventos processados. Logo abaixo vocé poderd encontrar
um exemplo das informag¢Ges armazenadas.

| Eile Edit View Terminal Go Help
!
|[Time: 2004/07/09 19:39:46.522] [System: ConnectorAgent] [SS: SystemTestConnector] [Thread: WT=1 (#1209690911)] [T
ype: Trace] [Mesg: :class com.crossworlds.DataHandlers.text.namevalue :Exiting setAttrList(BusinessObjectInterface
) for business object Employee]
[Time: 2004/07/09 19:39:46.522] [System: ConnectorAgent] [SS: SystemTestConnector] [Thread: WI=1 (#1209690911)] [T
ype: Trace] [Mesg: :class com.crossworlds.DataHandlers.text.namevalue :Exiting serializeBO(BusinessObjectInterface
, boolean) for business object Employee main BO flag true]
[Time: 2004/07/09 19:39:46.522] [System: ConnectorAgent] [SS: SystemTestConnector] [Thread: WI=1 (#1209690911)] [T
ype: Trace] [Mesg: :class com.crossworlds.DataHandlers.text.namevalue :Exiting getStringFromBO(BusinessObjectInter
face) for business object Employee]
[Time: 2004/07/09 19:39:46.522] [System: ConnectorAgent] [SS: SystemTestConnector] [Thread: WI=1 (#1209690911)] [T
ype: Trace] [Mesg: : JTextBOStringHandler: :handleBOEvent() : Created the string= { BusinessObject = Employee

Verb = Create

AttributeCount = 10

EmployeeId = 14963840

FirstName = Frank

LastName = Jones

SocialSecurityNumber = 142-72-4051

Salary = 15.00

Hours = 40

Comments = Hired for chip design initiative.

Revenue = 1000000

PhoneNumber = 744-289-5848

ObjectEventId = Fri Jul 09 19:39:22 CST 20041
} from BO= {Employee } successfully]
[Time: 2004/07/09 19:39:46.528] [System: ConnectorAgent] [SS: SystemTestConnector] [Thread: WI=1 (#1209690911)] [T
ype: Trace] [Mesg: :
| FileRecordWriter :: Updating FileSegNo.]
|[Time: 2004/07/09 19:39:49.994] [System: ConnectorAgent] [SS: SystemTestConnector] [Thread: WI=1 (#1209690911)] [T
vpe: Trace] [Mesg: :
| FileRecordwWriter :: Updating OutputLog.]
i[Time: 2004/07/09 19:39:49.994] [System: ConnectorAgent] [SS: SystemTestConnector] [Thread: WT=1 (#1209690911)] [T
jype: Trace] [Mesg: :
| JTextBOStringHandler:: Leaving handleBOEvent()] 4
E(Time: 2004/07/09 19:39:49.994] [System: ConnectorAgent] [SS: SystemTestConnector] [Thread: WT=1 (#1209690911)] [T
lype: Trace] [Mesg: :JTExtBOHandler::doVerbFor() : Processing successful for BO = {Employee.Create}]

Na visualizagdo do InterChange Server Component Management no System
Manager, clique com o botdo direito em SystemTestObject collaboration object
e, em seguida, clique em Statistics na barra de menus para abrir a visualizacdo
Statistics.

Nota: A visualizagdo Statistics mostra informagdes sobre os eventos
processados por uma colaboragdo. As informagdes contidas nesta
visualizagdo sdo tteis quando vocé estiver testando uma interface de
processos de negocios.

Se a janela do System Manager nao estiver maximizada, clique com o botao
direito na barra de titulo da janela do System Manager e, em seguida, clique
em Maximize no menu de contexto para expandi-la complemente.

A visualizagdo Statistics, que vocé abriu para o objeto de colaboragao
SystemTestObject no System Manager, na etapa El exibe os contadores para o
numero total de eventos processados, quando eventos foram bem-sucedidos e
quantos eventos sofreram falhas. A interface foi projetada para ocasionalmente
causar falhas em um evento, para que vocé possa visualizar tanto fluxos com
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falhas como fluxos bem-sucedidos. A visualizacdo Statistics é mostrada abaixo.

Q%SystemTestObject - WebSpherelCs X i
! Calls i Events
: Total 0 142
FT"'“E | | Successful 0 134
| Start: 2004.07.09 19:33:56 , C5T | | Faled o 8
‘ Total up: O hrs, 37 mins, 5 secs 1
| L
—Flow Status
Flows with duration greater than the time ID ﬁ hts !D :j mins Detailsi

Flows Initistor ID | Duration

SystemTestConnector_Fri Jul 09 20:08:03 C5T 2004129 0 hrs, 0 mins, 3 secs
~Flows Control

Buffered Events: O Blocked Status: false

Max Event Capacity: 2147483647 Events Pending in DE: O
1m Tl
|
|
;!
el
2 1
Queued Current ratefeventsiming - Max number of concurrent events configured: 1
1 0 6.0 Mean service time (sec): 12.156323943661972

5. Abra a pasta /ProductDir/Samples/SystemTest/data, que é o caminho de instalagdo
padrao do IBM WebSphere Business Integration Server Express em sua
maquina, para visualizar os arquivos criados pelo conector conforme ele
processa os dados.

6. Apods permitir que a interface seja executada por varios minutos, clique com o
botado direito em SystemTestConnector na visualizagdo InterChange Server
Component Management no System Manager e, em seguida, clique em Shut
Down SystemTestConnector.

Ap6s ter concluido estas instrugdes, vocé terd verificado se o InterChange Server
Express foi iniciado e se os componentes principais do sistema de integragao
podem implementar, iniciar, processar dados de negdcios e se podem ser
encerrados. Isto indica que o sistema estd instalado corretamente e que pode
suportar desenvolvimento, testes e producdo subseqiientes

Préxima Etapa a Ser Executada

Vocé deve, no entanto, limpar os objetos de negdcios em sua instalagdo antes de
utilizar o IBM WebSphere Business Integration Server Express. Va para o
[Capitulo 5, “Limpando Objetos de Negdcios”, na pagina 35 e siga as instrugodes
fornecidas para importagdo do arquivo de pacote BIA_BO_BaseCollabBOs.jar na
biblioteca de componentes de integragdo do WBIExpressLibrary e, em seguida,
implemente os objetos de negdcios Customer e Employee no servidor.
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Capitulo 5. Limpando Objetos de Negodcios

Apbs validar seu sistema com sucesso, sera necessario “limpar ” os objetos de
negdcios. Para fazer isto, importe o arquivo de pacote BIA_BO_BaseCollabBOs.jar
na biblioteca do componente de integracdo WBIExpressLibrary e implemente os
objetos de negdciosCustomer e Employee no servidor.

Este capitulo inclui as seguintes secdes:

“Importando o Arquivo de Pacote BIA_BO_BaseCollabBOs jar”]

“Implementando os Objetos de Negdcios Customer e Employee no Servidor” na|

pagina 36]

“Préximas Etapas a Serem Executadas” na pagina 36|

Importando o Arquivo de Pacote BIA_BO_BaseCollabBOs.jar

Execute as seguintes a¢des para importar o arquivo BIA_BO_BaseCollabBOs.jar na
biblioteca de componentes de integracdo do WBIExpressLibrary.

Importante: Caso existam componentes com o mesmo nome daquelas no pacote
que estd importando, o System Manager substituird os componentes existentes sem
aviso.

1.

© Copyright IBM Corp. 2004

No System Manager, clique com o botado direito em WBIExpressLibrary
integration component library e clique em Import from Repository File no
menu de contexto. O System Manager exibira o assistente “Import Repository
File”.

Na tela “Import Repository File”, assegure-se de que o menu drop-down
“Integration Component Library Name” contenha o nome da biblioteca na qual
deseja importar os componentes.

Se tiver iniciado o assistente “Import from Repository File” a partir de uma
biblioteca que ndo seja aquela na qual deseja importar os componentes, vocé
poderéd alterar o destino desta maneira, em vez de fechar o assistente e inicid-lo
novamente.

Plataformas Windows: Clique em Browse proximo ao campo “InterChange
server repository file” e, em seguida, selecione o arquivo
BIA_BO_BaseCollabBOs.jar na pasta ProductDir\repository.

Plataforma Linux: Clique em Browse proximo ao campo “InterChange server
repository file”, e selecione o arquivo BIA_BO_BaseCollabBOs.jar na pasta
ProductDir/repository.

Plataforma OS/400:
a. Mapeie uma unidade para o sistema OS/400.

b. Clique com o botédo direito em Meu Computador em seu desktop, e, em
seguida, selecione Mapear unidade de rede....

C. A partir da interface gréfica com o usuario “Mapear unidade de rede”,
selecione uma letra de unidade, e digite as seguintes informag¢des no campo
pasta: \\os400Name\root em que 0s400Name é o nome do sistema OS/400
ou seu endereco IP.

d. Clique em Browse proximo ao campo “InterChange server repository file”
e, em seguida, acesse a unidade mapeada e selecione o arquivo
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BIA_BO_BaseCollabBOs.jar no diretério
\QIBM\ProdData\WBIServer43\ product\repository\.

4. Clique em Finish.

Importante: Nao utilize o item de menu File > Import no Workbench para
importar um arquivo de pacote. Embora o assistente para “arquivo Zip” funcione
bem com archives que tenham a extensdo .jar e com arquivo de pacote do
InterChange Server Express que possuam extensdo .jar, o assistente para “arquivo
Zip” ndo funciona corretamente com arquivos de pacote.

Implementando os Objetos de Negocios Customer e Employee no
Servidor

Vocé podera implementar componentes em uma instancia do InterChange Server
Express utilizando o método arrastar e soltar.

1. Assegure-se de que o InterChange Server Express esteja iniciado e que o
System Manager esteja conectado a ele.

2. No System Manager, expanda Integration Component Libraries >
WBIExpressLibrary > Business Objects. Selecione o objeto de negdécios
Customer.

3. Pressione a tecla Ctrl e mantenha-a pressionada.

4. Desloque a lista e selecione o objeto de negdcios Employee.

5. Arraste e solte os objetos de negdcios selecionados na instancia do
WebSpherelCS do InterChange Server na visualizagdo InterChange Server
Component Management para implementa-los.

Préximas Etapas a Serem Executadas

Ap6s concluir a execucdo das instrugdes fornecidas neste documento, consulte os
documentos listados abaixo para saber o que vocé deve fazer a seguir.

* DPara obter informacdes sobre o produto IBM WebSphere Business Integration
Server Express e sobre as etapas necessarias para se implementar uma solugao,
consulte a publicagdo Implementation Guide do Sistema.

* Para obter informacdes sobre a instalagdo dos Pacotes de Capacidade do
Adaptador ou de Colaboragdo opcionais, disponiveis com o produto WebSphere
Business Integration Server Express Plus, consulte o guia de instalagdo para sua
plataforma: WebSphere Business Integration Server Express Installation Guide for
Windows, WebSphere Business Integration Server Express Installation Guide for
0S5/400 ou WebSphere Business Integration Server Express Installation Guide for
Linux.

* Para obter informacdes sobre a execugdo das tarefas de configuragdo finais para
sua implementacdo, incluindo a configuracdo dos adaptadores instalados com o
WebSphere Business Integration Server Express e com o Pacote de Capacidade
do Adaptador opcional, consulte o guia de instalagdo para sua plataforma:
WebSphere Business Integration Server Express Installation Guide for Windows,
WebSphere Business Integration Server Express Installation Guide for OS/400 ou
WebSphere Business Integration Server Express Installation Guide for Linux.
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Avisos

Avisos

E possivel que a IBM néo oferega os produtos, servigos ou recursos discutidos
nesta publicagdo em outros paises. Consulte um representante IBM local para obter
informagdes sobre produtos e servigos disponiveis atualmente em sua area.
Qualquer referéncia a produtos, programas ou servigos IBM ndo significa que
apenas produtos, programas ou servicos IBM possam ser utilizados. Qualquer
produto, programa ou servico funcionalmente equivalente, que ndo infrinja
nenhum direito de propriedade intelectual da IBM ou quaisquer outros direitos da
IBM podera ser utilizado em substitui¢do a este produto, programa ou servigo.
Entretanto, a avaliagdo e verificagdo da operagdo de qualquer produto, programa
ou servigo nao-IBM sao de responsabilidade do Cliente.

A IBM pode ter patentes ou solicitagdes de patentes relativas a assuntos tratados
nesta publicagdo. O fornecimento desta publicacdo nao garante ao Cliente nenhum
direito sobre tais patentes. Pedidos de licenca devem ser enviados, por escrito,
para:

Geréncia de Rela¢oes Comerciais e Industriais da IBM Brasil - Av. Pasteur, 138-146 -
Botafogo - Rio de Janeiro, R] - CEP 22290-240

O parégrafo a seguir ndo se aplica a nenhum pais em que tais disposi¢oes nao
estejam de acordo com a legislagdo local:

A INTERNATIONAL BUSINESS MACHINES CORPORATION FORNECE ESTA
PUBLICACAO "NO ESTADO EM QUE SE ENCONTRA”, SEM GARANTIA DE
NENHUM TIPO, SEJA EXPRESSA OU IMPLICITA, INCLUINDO, MAS NAO SE
LIMITANDO, A GARANTIAS IMPLICITAS DE NAO-VIOLACAO, MERCADO OU
ADEQUACAO A UM DETERMINADO PROPOSITO. Alguns paises nao permitem
a exclusdo de garantias expressas ou implicitas em certas transagdes; portanto, esta
disposicao pode ndo se aplicar ao Cliente.

Estas informagdes podem incluir imprecisdes técnicas ou erros tipograficos.
Periodicamente, sdo feitas alteracdes nas informagdes aqui contidas; tais alteragdes
serdo incorporadas em futuras edi¢des desta publicacdo. A IBM pode, a qualquer
momento, aperfeicoar e/ou alterar os produtos e/ou programas descritos nesta
publicacdo, sem aviso prévio.

Referéncias nestas informagoes a Web sites nao-IBM sdo fornecidas apenas por
conveniéncia e ndo representam de forma alguma um endosso a esses Web sites.
Os materiais contidos nestes Web sites ndo fazem parte dos materiais deste
produto IBM e a utilizagdo destes Web sites é de inteira responsabilidade do
Cliente.

A IBM pode utilizar ou distribuir as informagdes fornecidas da forma que julgar
apropriada sem incorrer em qualquer obrigagdo para com o Cliente.

Licenciados deste programa que desejam obter informagdes sobre este assunto com
objetivo de permitir: (i) a troca de informagdes entre programas criados
independentemente e outros programas (incluindo este) e (ii) a utilizagdo mttua
das informacgodes trocadas, devem entrar em contato com:
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Geréncia de Relagoes Comerciais e Industriais da IBM Brasil - Av. Pasteur, 138-146 -
Botafogo - Rio de Janeiro, R] - CEP 22290-240

Tais informagdes podem estar disponiveis, sujeitas a termos e condi¢des
apropriadas, incluindo em alguns casos o pagamento de uma taxa.

O programa licenciado descrito neste documento e todo o material licenciado
disponivel sdo fornecidos pela IBM sob os termos do Contrato com o Cliente IBM,
do Contrato de Licenca do Programa Internacional IBM ou de qualquer outro
contrato equivalente.

Todos os dados de desempenho aqui contidos foram determinados em um
ambiente controlado. Portanto, os resultados obtidos em outros ambientes
operacionais podem variar significativamente. Algumas medidas podem ter sido
tomadas em sistemas de nivel de desenvolvimento e ndo ha garantia de que estas
medidas serdo iguais em sistemas geralmente disponiveis. Além disso, algumas
medidas podem ter sido estimadas por extrapolagdo. Os resultados reais podem
variar. Os usudrios deste documento devem verificar os dados aplicaveis para seu
ambiente especifico.

As informacoes relativas a produtos ndo-IBM foram obtidas junto aos fornecedores
dos respectivos produtos, de seus antincios publicados ou de outras fontes
disponiveis publicamente. A IBM néo testou estes produtos e ndo pode confirmar a
precisdo de seu desempenho, compatibilidade nem qualquer outra reivindicagido
relacionada a produtos ndo-IBM. Dividas sobre os recursos de produtos nao-IBM
devem ser encaminhadas diretamente a seus fornecedores.

Estas informagodes contém exemplos de dados e relatdrios utilizados nas operagdes
diarias de negdécios. Para ilustra-los da forma mais completa possivel, os exemplos
podem incluir nomes de individuos, empresas, marcas e produtos. Todos estes
nomes sao ficticios e qualquer semelhanga com nomes e enderegos utilizados por
uma empresa real é mera coincidéncia.

Todas as declaragdes relacionadas aos objetivos e intengdes futuras da IBM estdo
sujeitas a alteragdes ou cancelamento sem aviso prévio e representam apenas metas
e objetivos.

LICENCA DE COPYRIGHT

Estas informagGes contém programas de aplicativos de exemplo na linguagem
fonte, ilustrando as técnicas de programacdo em diversas plataformas operacionais.
Vocé pode copiar, modificar e distribuir estes programas de exemplo sem a
necessidade de pagar a IBM, com objetivos de desenvolvimento, utilizac¢do,
marketing ou distribuicdo de programas aplicativos em conformidade com a
interface de programacdo de aplicativo para a plataforma operacional para a qual
os programas de exemplo sdo criados. Esses exemplos nao foram testados
completamente em todas as condig¢des. Portanto, a IBM ndo pode garantir ou
implicar a confiabilidade, manuten¢do ou fungdo destes programas.

Informacgdes sobre a Interface de Programacao

As informacoes sobre interface de programagdo, se fornecidas, destinam-se a
facilitar a criagdo de software aplicativo utilizando este programa.

As interfaces de programacdo de uso geral permitem que o cliente desenvolva o
software aplicativo que obtém os servicos das ferramentas deste programa.
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No entanto, estas informagdes também podem conter informacgoes sobre
diagndsticos, modificagdes e ajustes. As informagdes sobre diagnésticos,
modificagdes e ajustes sdo fornecidas para ajuda-lo a depurar seu software
aplicativo.

Nota: Nao utilize estas informagées sobre diagnésticos, modificagdes e ajustes
como uma interface de programacao, pois elas estdo sujeitas a alteracdes.

Marcas Registradas e Marcas de Servico

Os termos a seguir sdo marcas ou marcas registradas da International Business
Machines Corporation nos Estados Unidos e/ou em outros paises:

IBM

o logotipo IBM
AIX
CrossWorlds
DB2

DB2 Universal Database
Domino

Lotus

Lotus Notes
MQIntegrator
MQSeries

Tivoli
WebSphere

Microsoft, Windows, Windows NT e o logotipo Windows sao marcas registradas
da Microsoft Corporation nos Estados Unidos e/ou em outros paises.

MMX, Pentium e ProShare sdo marcas ou marcas registradas da Intel Corporation
nos Estados Unidos e/ou em outros paises.

Java e todas as marcas registradas baseadas em Java sdo marcas registradas da Sun
Microsystems, Inc. nos Estados Unidos e/ou em outros paises.

UNIX é uma marca registrada do The Open Group nos Estados Unidos e em
outros paises.

Linux é uma marca registrada de Linus Torvalds nos Estados Unidos e/ou em
outros paises.

Outros nomes de empresas, produtos ou servicos podem ser marcas registradas ou
marcas de servico de terceiros.

Este produto inclui software desenvolvido pelo Eclipse Project
(http:/ /www.eclipse.org/).
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WebSphere Business Integration Server Express V4.3.1 e WebSphere Business
Integration Server Express Plus V4.3.1
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